
 

  

CSS450 

Optical Rheology System 

Linkam Scientific Instruments 

USER GUIDE 



 

2 

Contents 

 
Safety Information ............................................................................. 4 
 Important Notice ........................................................................................ 4  
 Requirements for Safe Use ........................................................................... 4 
 Caution Labels and Indicators ...................................................................... 4 
 Handling Liquid Nitrogen  ............................................................................. 4 
 Filling the Dewar......................................................................................... 5  
 Equipment Maintenance  .............................................................................. 5 

Informations de sécurité ..................................................................... 5  
 Note importante ......................................................................................... 5  
 Exigences en matière de sécurité d'utilisation ................................................. 5  
 Étiquettes d'avertissement et indicateurs ....................................................... 6  
 Manipulation de l'azote liquid ....................................................................... 6  
 Remplissage du vase Dewar ......................................................................... 6  
 Entretien de l'appareil ................................................................................. 6  
Introduction ...................................................................................... 7 
Before using your equipment ............................................................... 7 
Warranty ........................................................................................... 7 
Technical support ............................................................................... 7 
Feedback .......................................................................................... 7 
Equipment Operation .......................................................................... 7 
Introduction to CSS450 stage .............................................................. 8 
Anatomy of a CSS450 ......................................................................... 9  
Accessories ...................................................................................... 10 
Getting Started ................................................................................. 11 
 Installing Linksys32 on a PC  ....................................................................... 11 
 Stand Assembly ......................................................................................... 11  
 Assembling the Lid and Base ....................................................................... 12 
 Connecting the Lemo cable ......................................................................... 12 
Mounting on to a Microscope .............................................................. 13 
 Mounting on to a Dovetail ........................................................................... 13 
 Set up Kohler Illumination .......................................................................... 13 
Introduction to CSS450 System Controller ......................................................... 14 
 Back Panel Cable Connections ..................................................................... 14 
 Stage Connector ........................................................................................ 14  
 Instrument Bus ......................................................................................... 14  
 Expansion Boards  ..................................................................................... 14 
 External Input and Output Sockets .............................................................. 14  
 USB Connector .......................................................................................... 14  
 RS232 Connector ....................................................................................... 14 
 LinkPad Connector ..................................................................................... 14  
LNP95 Liquid Nitrogen Pump ............................................................... 15 
 Introduction .............................................................................................. 15 
 Remove Transit Screws .............................................................................. 15 
Connecting the Stage to the Controller .............................................................. 16 
 Mains Connection....................................................................................... 16 
Connecting the Water Cooling Supply / Circulator .................................. 17 
Connecting the Liquid Nitrogen Pump for Cryo-CSS450 System .............. 18 
 Connecting the LNP95 ................................................................................ 18 
Setting up the Linksys32 Software ...................................................... 20 
 Changing the Comm Port Number ................................................................ 21 



 

3 

Using Linksys32 Software .................................................................. 21 
 Linksys32 Tool Bar .................................................................................... 22 
 CSS450 Tool Bar ....................................................................................... 22 
 CSS Status Window ................................................................................... 22 
 Sensor Indicators ...................................................................................... 22 
 Jog Controls (Manual Mode) ....................................................................... 22 
Loading the Sample .......................................................................... 23 
Start the Shearing Experiment ........................................................... 24 
 Using the Shear Motor Profile ..................................................................... 24 
 Start the Profile ........................................................................................ 26 
 Adjusting The Shear Parameters ................................................................. 26 
 General Setup .......................................................................................... 26 
 Velocities ................................................................................................. 26 
Finish a Shearing Experiment ............................................................. 27 
Maintenance Procedures .................................................................... 28 
 Changing the Windows .............................................................................. 28 
 External Window Replacement .................................................................... 28 
 Base Window Replacement ......................................................................... 28 
 Lid Window Replacement ........................................................................... 29 
Setting the Sensors - Zero, Lid and Reference  ..................................... 30 
 Manually Setting the Windows to Zero Point  ................................................ 30 
Using the CSS-450 Gas Purge and Vertical Seal stage  .......................... 35 
 Using the Purge ports ................................................................................ 35 
 Base Window Replacement ......................................................................... 35 
Troubleshooting ................................................................................ 36 
 Unable to set a gap, Lid seems stuck ........................................................... 36 
 Comm port message ................................................................................. 36 
 Motor doesn’t start .................................................................................... 36 
 Lid can rock slightly when the lid nuts are off ............................................... 37  
 Temperature appears to be several degrees below the displayed temperature  . 37 
Cooling Fault Diagnosis...................................................................... 37  
 The cooling rate is less than Specified.......................................................... 37 
Appendix 1 : Shear and Strain Explanation .......................................... 38  
 Shear Control ........................................................................................... 38  
 Shear Rate ............................................................................................... 38 
 Strain (Shear) value  ................................................................................. 38 
 Observation Radius  .................................................................................. 38 
Appendix 2 : Spare Parts List  ............................................................ 39 
Appendix 3 : Declaration of Conformity ............................................... 40 
Appendix 4 : Technical Specification .................................................... 41 
 CSS450 Stage Technical Specification  ......................................................... 41 
 CSS450 Controller Technical Specification  ................................................... 41 
 CSS450 Controller Equipment Ratings  ........................................................ 41 
 RS232 Computer Interface ......................................................................... 41 
 USB Interface ........................................................................................... 41 
 External input and output sockets  .............................................................. 41 
 CSS450 Motor Board  ................................................................................ 42 
 Optional LinkPad  ...................................................................................... 42 
 LinkPad Equipment Ratings ........................................................................ 42 
 LNP95 Liquid Nitrogen Pump ...................................................................... 42 
 LNP95 Equipment Ratings .......................................................................... 42 
Contact Information .......................................................................... 44 



 

4 

Safety Information 
Important Notice 
Please check that your Linkam equipment has not been damaged during transport.  
If there is any evidence of external damage to the electrical items:- 
 

do not connect the power cord or switch the unit on. 
 

Contact Linkam Scientific Instruments Ltd or their appointed distributor immediately.  Your warranty may be 
impaired if Linkam is not informed of any transport damage within 7 working days of delivery. 
 

Requirements for Safe Use 
1. Read all of this guide before using the equipment.  Save these instructions for later use. 
2. Follow all warnings and instructions marked on any of your Linkam equipment, or  

contained within the manuals. 
3. If for any reason the mains fuse needs to be replaced then it must be replaced by one of the same type and 

rating as shown in the equipment ratings. 
4. To prevent electric shock, do not remove the cover of the equipment. 
5. Never use the equipment if the power cord has been damaged.  Do not allow any heavy objects to rest on 

the power cord.  Never lay the power cord on the floor. 
6. The mains cord set is the overall disconnect and must remain accessible. 
7. If the equipment is used in a manner not specified by the manufacturer, the protection provided by the 

equipment may be impaired. 
8. Do not obstruct any ventilation holes. Do not attempt to insert anything into these  

openings.  Provide adequate ventilation of at least 75mm all around the equipment. 
9. Do not expose the equipment to water.  If for any reason it gets wet, then remove the power cord from the 

mains outlet and contact Linkam Scientific Technical Support.  
10. The equipment is not intended to be used outdoors. 
11. Each product is equipped with a 3-wire grounded (earth) power plug or a free-end 3 wire power cord.  The 

plug only fits into a grounded-type outlet.  The free-end power cord should be connected to a correctly 
grounded 3-wire power outlet.  Do not defeat the purpose of the grounded (earth) type plug. 
Free - end power cords are colour coded as follows:- 

   Colour   Function 

   Brown   Live 

   Blue   Neutral 
   Green/Yellow Earth (Ground) 
 

12. The power cord must be an appropriately rated and approved cord-set for the country it is being used in. 
13. If any problems occur then remove the power cord from the mains outlet and contact Linkam  

Scientific Technical Support. 
14. NO attempt should be made to repair or modify the equipment in any way, as there are no user  

replaceable parts. Any servicing should be carried out by qualified service personnel.  Do not remove the 
cover from the equipment unless the power cord has been removed from the mains outlet.  

15. After servicing the safe state of the equipment must be checked. 
 
Caution Labels and Indicators 
This safety symbol on the back panel warns the user :  
 Do not to make or remove any connections while the unit is powered on. 
 Do not to remove the cover. 
 Servicing should only be done by qualified service personnel. 
 

This safety symbol is seen on the back panel of the equipment and warns the user:  
 To avoid electric shock the power cord protective grounding conductor must be  
 connected to earth or ground. 
 

! 
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Handling Liquid Nitrogen 
To cool samples below room temperature a CSS-LNP95 liquid nitrogen pump system is required.  Always use 
liquid nitrogen in a well ventilated room as there is a danger of asphyxiation. 
Refer to your health and safety officer regarding instructions on how to handle liquid nitrogen safely and ensure 
that you have the correct safety equipment including gloves and safety goggles. 
 
Filling the Dewar 
Fill the Dewar approximately 2/3 full and replace the lid with the siphon attached, but do not fasten the catches. 
Wait for the liquid nitrogen to stop bubbling before fastening. 
When the lid is removed always ensure you place it with the black capillary tube pointing upwards. It is easily 
damaged or creased which will impair N2 flow and the performance of the system. 
 
Equipment Maintenance 
The equipment does not require any regular maintenance.  Contact Linkam should you require any maintenance. 
Before cleaning the case or front panel of the equipment, remove the mains cord from the mains  
outlet.  Use a small quantity of isopropyl alcohol (IPA) on a soft cloth and gently wipe the surface.   
 

Informations de sécurité 
 
Note importante 
Veuillez vérifier que votre appareil Linkam n'a pas été endommagé pendant le transport.  
S'il présente une trace quelconque d'endommagement aux éléments électriques : 
 

ne raccordez pas le cordon d'alimentation et n'allumez pas l'appareil. 
  

Contactez Linkam Scientific Instruments Ltd ou son distributeur désigné immédiatement. Votre garantie pourrait 
être réduite si Linkam n'est pas informée de tout dommage causé par le transport dans les 7 jours ouvrables  
suivant la livraison. 
  

Exigences en matière de sécurité d'utilisation 
1. Lisez ce guide intégralement avant d'utiliser l'appareil. Conservez ces instructions pour un usage ultérieur. 
2. Suivez toutes les mises en garde et instructions marquées sur toute pièce de votre appareil, ou figurant 

dans les manuels. 
3. Si pour une quelconque raison le fusible secteur doit être remplacé, il faut le remplacer par un fusible du 

même type et avec les mêmes caractéristiques nominales que celles indiquées dans les caractéristiques 
nominales de l'appareil. 

4. Pour prévenir l'électrocution, n'enlevez pas le couvercle de l'appareil. 
5. N'utilisez jamais l'appareil si le cordon d'alimentation a été endommagé. Ne laissez pas d'objets lourds 

appuyés sur le cordon d'alimentation. Ne posez jamais le cordon d'alimentation sur le sol. 
6. Le secteur cordon est la déconnexion globale et doit rester accessible. 
7. Si l'équipement est utilisé d'une manière non spécifiée par le fabricant, la protection fournie par l'équipe-

ment peut être altérée. 
8. N'obstruez aucun des orifices de ventilation. N'essayez pas d'insérer quoi que ce soit dans ces ouvertures. 

Prévoyez un espace de ventilation adéquat d'au moins 75 mm autour de l'appareil. 
9. N'exposez pas l'appareil à l'eau. Si pour une quelconque raison l'appareil est mouillé, retirez le cordon 

d'alimentation de la prise de courant et contactez le support technique de Linkam. 
10. L'appareil n'est pas destiné à un usage à l'extérieur. 
11. Chaque produit est équipé d'une fiche d'alimentation mise à la terre ou d'un cordon d'alimentation avec 3 

fils à extrémité libre. La fiche ne s'insère que dans une prise de courant mise à la terre. Le cordon  
d'alimentation à extrémités libres doit être raccordé à une prise de courant à 3 fils correctement mise à la 
terre. N'empêchez pas le fonctionnement de la fiche mise à la terre. 

    Les cordons d'alimentation à extrémité libre suivent les codes couleur suivants : 
 

   Couleur   Fonction 

   Marron   conducteur de phase 

   Bleu   conducteur neutre 

   Vert/jaune  mise à la terre 



 

6 

12. Le cordon d'alimentation doit être constitué d'un ensemble de câbles répondant aux caractéristiques nomi-
nales et approuvé dans le pays d'utilisation. 

13. Si un problème survient, débranchez le cordon d'alimentation de la prise de courant et contactez le support 
technique de Linkam. 

14. Il convient de NE PAS tenter quoi que ce soit pour réparer ou modifier l'appareil en aucune façon, dans la 
mesure où il n'y a aucune pièce remplaçable par l'utilisateur. Tout entretien doit être effectué par du  
personnel qualifié. N'enlevez le couvercle de l'appareil que si le cordon d'alimentation a été débranché de 
la prise de courant. 

15. Après l'entretien de l'état de sécurité de l'équipement doit être vérifiée. 
 
Étiquettes d'avertissement et indicateurs 
Ce symbole de sécurité sur le panneau arrière avertit l'utilisateur : 
 N'effectuez ou n'enlevez aucun raccordement quand l'appareil est sous tension. 
 N'enlevez pas le couvercle. 
 L'entretien doit être effectué exclusivement par du personnel qualifié. 
  

Ce symbole de sécurité est visible sur le panneau arrière de l'appareil et avertit l'utilisateur : 
 Pour éviter l'électrocution, le conducteur de protection du cordon d'alimentation doit être 
 raccordé à la terre. 
  

Manipulation de l'azote liquide 
Pour refroidir les échantillons en dessous de la température ambiante, un système de pompe à azote liquide 
LNP95 est requis. Manipulez toujours l'azote liquide dans un local bien ventilé, car il présente des risques  
d'asphyxie. 
Référez-vous à votre agent de santé et sécurité en ce qui concerne les instructions sur la manière de manipuler 
l'azote liquide de façon sûre et assurez-vous de porter l'équipement de sécurité adapté incluant des gants et des 
lunettes de protection. 
 

Remplissage du vase Dewar 
Remplissez le Dewar jusqu'à environ 2/3 et remplacez le couvercle par le siphon attaché, mais ne scellez pas les 
fixations. Attendez la fin du bouillonnement de l'azote liquide avant de sceller le Dewar. 
Lorsque le couvercle est enlevé, assurez-vous de la déposer avec le tube capillaire noir pointant vers le haut. Il 
peut être facilement endommagé ou plié, ce qui affecterait le flux de N2 et la performance du système. 
 
Entretien de l'appareil 
L'appareil ne nécessite pas d'entretien régulier. Contactez Linkam si vous souhaitez procéder à un entretien. 
Avant de nettoyer le boîtier ou le panneau avant de l'appareil, débranchez le cordon secteur de la prise de cou-
rant. Utilisez une petite quantité d'alcool ispropylique (IPA) sur un chiffon doux et frottez délicatement la  
surface. 

! 



 

7 

Introduction 
 

Thank you for purchasing a Linkam system. Please take 
the time to read through all the manuals, as it will help 
you to fully understand the equipment. 
 

Please check you have received the following items:- 
1:  CSS450 System Controller 
2:  Power cord 

3:  RS232 cable for PC connection 

4:  USB Type A to B cable  
5:  Manual 
6&7: Optional LinkPad and Stylus 

 

Before using your Equipment 
 

Please register your products by going to www.linkam.co.uk and clicking on the product/software registration 
button. You will need to register your equipment with us to: 
 

 Activate your warranty and technical support. 
 Access the online setup videos. 
  Permanently unlock the Linksys32 software by use of a product key (if purchased). 
 

To unlock the Linksys32 software a product key must be requested which is supplied by Linkam from a 
customers product registration number. This is generated after installing the Linksys32 software by running the 
register program from Start-Programs-Linkam-Register. See the Linksys32 manual for further installation 
instructions. 
 

Warranty 
 

This equipment has a warranty against defects in material and workmanship for a period of 12 months.  Linkam 
will either repair or replace products that prove to be defective.  For warranty service or repair, this product must 
be returned to Linkam or a designated service facility. 
The warranty shall not apply to defects resulting from interfacing, unauthorized modification or misuse, opera-
tion outside of the environmental specifications for the product, or improper site preparation or  
maintenance. 
 

Technical Support 
 

Any technical questions or queries should be emailed to the Technical Support Department at  
support@linkam.co.uk 

 

Feedback 
 

Your feedback will be greatly appreciated, please go to www.linkam.co.uk to fill in the feedback form. 
 

Equipment Operation 
 

Warning: 
Do not connect or remove any leads to the CSS450 Controller while the unit is switched on at the mains 
supply. All connections must be in place before the CSS450 Shear Controller is switched on. 
 

If an LNP95 unit is being used it is important that it is switched on before the CSS450 unit, otherwise the  
equipment will not function correctly. 

2 
1 

7 
6 
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Introduction to CSS450 Shear 
Stage 
 

Thank you for purchasing the CSS450 system.  
The Cambridge Shearing System (CSS450) has 
been developed in collaboration with the Depart-
ment of Chemical Engineering at Cambridge 
University.  
 

The stage and its accessories are packed in the 
protective hard plastic case.  It’s recommended 
that you use this case to store the stage, when it is 
not in use for a long period of time. 
 

 

The CSS450 Shear Stage is made up from two 
parts, the Lid and Base (see pictures).  The stage 
is designed to fit on most standard upright micro-
scopes and has a temperature range from ambient 
(-50°C for Cryo-CSS450) to 450°C.   
 

Please take the time to read through this manual 
carefully, it will help you to get the most out of 
the system.  
 

 

 

 

 

Lid 

Shear Motor Gap Motor 

Base 

CSS450 System 
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Anatomy of a CSS450 
 

When in use, the sample is placed between two 
highly polished quartz windows that are parallel 
to within 2mm and each window is in close ther-
mal contact with a silver heater.  The Base win-
dow, located within the lower section of the shear-
ing stage, is attached to a metal carrier that can 
rotate under the control of the Shear Motor.  This 
motor is micro-stepped and has a specification of 
51200 steps per revolution.  
 

The Shear Motor can drive the system in three 
ways; steady velocity, step movement at constant 
velocity and an oscillatory motion with constant 
frequency and amplitude. 
 

When in use, the Lid is fixed on top of the Base.  
The gap between the windows can be set from 5 
to 2500μm and this is controlled by a stepping 
Gap Motor and micrometer built inside the body 
of stage.  The speed at which the Lid moves up 
and down may also be set.  Sensors in the body of 
the stage and Lid will determine the upper and 
lower limits. 
 

1. Water cooling connectors 

2. Window clamping ring 

3. 32mm tapered quartz Lid window (W32TQ) 
4. 55mm quartz Base window (W55Q) 
5. Window carrier 
 

 

1 1 

2 

3 

Lid 

5 

1 
1 

1 
1 

2 

Base  

4 

5 
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Accessories 
 

The accessories for the stage are supplied in an accessories kit (part no: 2053), containing the items in the 
picture below. 

1 

2 

3 

4 

5 

6 

7 

8 

9 10 11 

12 

13 

Number Part number Part description 

1 3016 Lid Nut (CSS-LN) 

2 3033 Motor Nut 

3 3011 18mm External Window Locking Tool 

4 2912 55mm Window Clamp Tool 

5 3003 Sensor Adjustment Tool 

6 2047 Base Window Carrier Tool 

7 3076+2911 Lid Window Clamping Tool and Tommy Bar 

8 2055 Clear PVC Water Cooling Tube 

9 2473 Lid Jacking Screw, M6x16mm 

10 2202 Water Valve Connectors (WVC) 

11 2200 Water/Gas Insert (WGI) 

12 N/A Set of Allen (hex) keys, 1.5, 2.0, 2.5 (ball point), 3.0, 4.0, 5.0mm,  

13 3078 55mm Window Sucker Tool 
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Getting Started 
 

When fully unpacked, check for the following 
items; CSS450 ‘Controller’, a mains power lead, 
RS232 lead and a CD with Linksys32 software. 
 

In a separate dedicated plastic case there will be a 
complete CSS450 Shearing ‘Stage’ consisting of 
the Lid, the Base, a flat packed Stand and an 
accessories kit. 
 

Installing Linksys32 on a PC 
Before getting started with the stage, it is advisa-
ble to load the Linksys32 software onto the PC 
(see Linksys32 Manual) and register the software 
with Linkam.   
 

Note: The CSS450 Controller requires a PC 
equipped with a Comm port  (RS232 connection), 
for the Controller to link with the PC.  If the PC 
does not have a  Comm port, consult your IT 
department to install a Comm port PCI card or a 
USB-to-Comm port adaptor. 
 

 

Stand Assembly 
Assemble the Stand as shown in the pictures, 
using the supplied 4.0mm hex key.    
 

The Stand is useful for holding the Lid while a 
sample is loaded or when the windows are 
cleaned. 
It can also be used to rest the complete shearing 
stage on when testing or when it is not in use on 
the microscope. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CSS450 System 



 

12 

 

Assembling the Lid and Base 
1. Place the Base on the Stand.   
2. Place the Lid on  top of the Base.  Make  sure 
 the three holes at the top right hand side corner 
 of the Base are aligned and matched with the 
 three sensor pins on the Lid (1).   
3. Use the two Lid Nuts supplied and screw them 
 into place, hand tight only.  The user might 
 need to use a finger to push and lift upward the 
 protruding shaft, which is located directly 
 underneath each thread to give more threads for 
 the Lid Nut to screw on to. 
 

The Lid can be removed by doing the reverse of 
the above procedure.  If the Lid Nut turns but 
does not unscrew, the Lid Nut may have been 
screwed on too tightly .  Press one finger and hold 
the protruding shaft underneath the stage to stop it 
turning. 
 

Note: Protective Caps 

 

There are four of these fitted over the alignment 
screws located in the lid. THESE SHOULD NOT 
be removed under any normal circumstances.  
They are aligned at the factory and any attempt to 
change these in any way will invalidate the war-
ranty. 
 

 

 

 

 

 

Connecting the Lemo Cable 
There are four leads connected into the Base.  
Connect the shortest cable which has a Lemo plug 
connected to it, into the Lemo socket  in the Lid. 
Line up the red dot on the plug with the red dot on 
the socket. 
 

This lead will provide the heating power and  
connect the temperature sensor to the Lid. 
 

When removing the Lid.  The Lemo cable can 
remain connected to the Lid if required, but use 
the Stand to rest the Lid on. 
 

Note: to disconnect the Lemo, e.g. to make clean-
ing the stage easier., hold the socket firmly and 
gently pull the plug away from the Lid. 

Lid Nut 

Protective cap 

Lid Nut 

Sensor pins 

1 

Lid Nut Lid Nut 
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2 

3 

Part no: 9548 

1 

Mounting on to a Microscope  
 

The microscope make and model was specified at 
the time of order, and the clamping set or adaptor 
plate are supplied specific to that set up.   
 

Note:  The CSS450 stage requires the objective 
lenses to have a minimum working distance of 
7.4mm. 
 

Mounting on to a Dovetail 
The following description for mounting the 
stage on the Linkam Imaging Station can 
also be applied to microscopes which have 
similar circular dovetail substage assemblies. 
 

Attach the Curved Clamps (part no. 9548) to the 
Microscope Fixing Plate (1), using the supplied 
hex screws (2.5mm) and to the outer most holes 
of the Microscope Fixing Plate.  
 

The two curved clamps are used to fix the 
CSS450  to the microscope.  To do this; adjust the 
two positioning screws (2) and thumb screw (3) 
so that they are showing about 5mm of thread on 
the inside edge of the Curved Clamps.  This will 
roughly position the stage in the centre of the 
dovetail. 
 

Place the Base onto the dovetail and using a 5x or 
10X objective lens, focus on the aperture of the 
heating block.  Using a hex screw driver to adjust 
the two positioning hex screws (2), so that the 
aperture is in the centre field of view of the opti-
cal light path.  Then use the thumb screw (3) to 
lock the stage in place. 
 

Set up Kohler Illumination 
Kohler illumination is a technique that provides 
optimum resolution and contrast in a light micro-
scope by aligning and focussing the transmitted 
illumination and critically setting the apertures of 
the microscope to best match the objective lens 
Numerical Aperture. 
 

To use Kohler illumination with the CSS450, a 
condenser lens with a minimum working distance 
of 15mm is needed.  Contact Linkam for further 
information about condenser extension lenses. 
 

For information about setting up Kohler Illumina-
tion and how to set up your microscope.  See the 
extremely informative ‘microscopy Primer’ on the 
Molecular Expressions website. 
http://micro.magnet.fsu.edu/primer/index.html 
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Introduction to CSS450 System Controller 
 
Back Panel Cable Connections 
Warning: To avoid any damage to the CSS450, switch the unit off before connecting or  removing any 
connections. 
 

1: Power socket  
2: Fuse holder 
3: Instrument Bus connector, for LNP95 

Liquid Nitrogen pump System.  
4: RS232 connector for PC Comm port  

connection. 
5: USB connector (used for firmware  

upgrade only). 
6: External input and output sockets.  
7: Stage connector. 

 

Stage Connector 
This supplies power to the stage and measures the temperature using platinum resistor sensors. 
 

Instrument Bus 
This connection is only used for the LNP95 Liquid Nitrogen Pump. If your stage has been supplied with an 
LNP95 then a cable will have been provided which is used to connect the CSS450 
to the LNP95. 
It may be necessary to pull back the sprung mounted violet moulding towards the 
cable before inserting the connector. 
 

Expansion Boards 
The CSS450 requires a motor expansion board, which requires the ’motor’ and ’sensor leads to be connected 
correctly. 
 

Any of the stages which use an expansion board will be marked with the same label as the CSS450 expansion 
board. 
 

External Input and Output Sockets 
There are three 2.5mm jack sockets (6) on the rear of the CSS450 for synchronising or controlling external 
equipment, see page 39 for the electrical specifications. 
 

USB Connector 
At present this is only used for updating the firmware in the CSS450 . 
 

RS232 Connector 
For a PC connection use the supplied RS232 crossover cable. 
 

LinkPad Connector 
If you have purchased a LinkPad then plug it into the LinkPad connector (3). 
 

 

 

  

Expansion boards 

7 

5 4 3 

2 6 
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LNP95 Liquid Nitrogen Pump 
 

Only read the following if the LNP95 Liquid Nitrogen Cooling Pump System is supplied with your system. 
The LNP95 System uses liquid nitrogen to cool the stage from ambient to -196ºC.  The speed of the LNP95 is 
automatically controlled from 1 to 100 by the CSS450.  Note: refer to the LNP95 manual for more information 

 

 

Introduction 
Please check that all of the following parts have been 
supplied with the LNP95 System. 
 

1. LNP95 Liquid Nitrogen Pump 

2. 2L Dewar (7L or 25L Dewar is available) 
3. Power cord  
4. Instrument Bus Cable for connection to the CSS450 

 

 

 

 

 

 

 

 

 

 

Remove Transit Screws 
Before using the LNP95 Liquid Nitrogen Pump Sys-
tem, remove the 4 transit screws marked by small 
yellow labels (5), from the base of the LNP95. These 
screws hold the pumps in place to avoid any damage in 
transit. 
 

 

 

 

 

 

 

Keep the screws safe by storing them in the holes (6) 
on the back panel as shown by the arrows.   
 

Should the LNP95 be returned for service or repair, the 
screws must be removed from the storage holes and 
used to secure the pumps for transit (5). 

5 

6 

1 
2 

3 4 
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Connect the Stage to the Controller 
 

The CSS450 Controller controls the temperature 
and the Shear and Gap motors of the stage. 
 

Refer to the back of the controller.  Connect the 
supplied RS232 lead from the RS232 socket on 
the back of the controller to the PC’s serial/Comm 
port.  All the long leads from the Base should be 
connected to the back panel of the controller.  
Each connector is unique and cannot be inserted 
into the incorrect socket. 
 

Make sure that the two screws on “D” type con-
nectors are tightened. 
 

Mains Connection 
Once the RS232 lead between the computer and 
the controller is in place, it does not matter which 
one is powered on first.  Plug the mains connector 
into the back of the controller and then into the 
mains outlet.  Use the On/Off switch to turn the 
power on or off. 
 

Note: do not remove any of these connections 
while the controller is powered on as this could 
damage the equipment.   
 

No attempt should be made to modify any of  the 
connections to the CSS450 Controller.  Warranty 
will be void. 
 

 

 

Connect 
CSS450 

Stage 

Connect 
CSS450 

Stage 

Connect 
CSS450 

Stage 

Connect 
interface  

to PC 

Connect to 
mains 
power 
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Connecting the Water Cooling  
Supply/Circulator 
 

When the CSS450 is used at temperatures exceed-
ing 200°C for a prolonged period of time it will 
become warm/hot to the touch.  To ensure that the 
stage is always safe to handle, a system of water-
cooling is recommended.   
 

Either a low-pressure water supply (mains) or a 
water pump may be used with a flow rate of ap-
proximately 0.3l/m.   
 

Linkam can supply a portable water circulator 
pump system (ECP) for this application.    
 

Some connectors and tubing are supplied with the 
stage. (Water connections at sides of stage need to 
be fitted using a 7mm spanner).  The tube has a 
inner diameter (I.D) of 3.0mm and an outside 
diameter (O.D) of 6.0mm.  To ensure even cool-
ing of the complete stage, connect the tubes to the 
stage as shown. 
 

Note: cut the tubing to a manageable length. i.e. 
not too long as it might tangle up and not too 
short, so that when Lid is taken off the Base, it 
can be placed on the Stand 

 

 

Water inlet  
(Base) 

Water outlet  
(Lid) 

Bypass loop 

(Base connection) 

Base  
connection 

Lid  
connection 
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CSS450 Controller 

LNP95 

Instrument Bus 
Cable 

Main cable power socket 

Cryo-CSS450 System 

Connecting the Liquid Nitrogen 
Pump for Cryo-CSS450 System 
 

Note: this is only appropriate if you have pur-
chased the Cryo-CSS450 system.  If not then go 
to the section, “Setting up the Linksys32 Soft-
ware”, page 18. 
 

A Cryo-CSS450 system adds liquid nitrogen 
cooling functionality to the CSS450 stage.  A dual 
output LNP95 Liquid Nitrogen Cooling Pump, 2L 
Dewar, power cable and I2C cable will be includ-
ed as additional parts. 
 

Connecting the LNP95 
Connect the CSS450 Controller as described on 
page 14 of this manual and connect the Instru-
ment Bus cable from the CSS450 controller to 
either one of the two Instrument Bus sockets on 
the LNP95. 
 

Fill the 2L Dewar with liquid nitrogen to approxi-
mately 2/3 thirds full and replace the lid.  DO 
NOT FASTEN the clips on straight away (read 
Safety Precaution; Handling Liquid Nitrogen, 
page 4 for more information).  Wait until the 
nitrogen has stopped boiling before fastening the 
catches.  Excess pressure can escape through the 
Teflon cap on the lid. 
 

There is a white plastic block on the base and on 
the top of the lid.  These blocks have two connect-
ors extending from them.  One is for the cooling 
pump (labelled LNP) and the other is for the 
Dewar siphon (labelled DF2). 
 

The CSS-LNP95 cooling pump has two silicon 
tubes extending from the front panel.  These tubes 

end in plastic white connectors with a 3mm outer 
diameter (O.D.) stainless steel side exhaust tube. 
Twist and gently push these white connectors 
onto the thin steel connectors on the Lid and base, 
labelled ‘LNP’. The bottom LNP siphon should 
connect to the base heater, and the top LNP si-
phon to the lid heater. 
 

The Dewar siphons assembly protrude from a 
large Teflon cap on the top lid of the Dewar.  The 
siphons are labelled ‘Lid’ and ‘Base’.  A thin 
black capillary tube extends from the end of each 
siphon, these tubes must be carefully inserted into 
the small steel connector protruding from the 
white blocks and labelled DF2.   
 

.   
 

 



 

19 

The small side exhaust tubes (1) protruding from 
the white connectors at the end of the LNP tubes 
vent the recycled nitrogen into the atmosphere. 
 

Silicon tubes (2) can be attached to these exhausts 
to utilise the recycled nitrogen that vent to the 
atmosphere to prevent condensation at the Lid or 
Base, or to simply flow nitrogen into the gap 
between the Lid and Base.  These tubes can be 
fixed into place using adhesive tape (3).  Variable 
lengths of silicon tube (O.D. 4mm, I.D. 2mm) can 
be sourced locally or directly from Linkam. 
 

 

 

 

 

 

 

 

 

 

 

 

 

When all the connections have been made, the 
CSS450 is ready to be used to cool the sample 
below room temperature to –50°C.   
 

The CSS450 Controller will communicate with 
the Liquid Nitrogen Pump (LNP95) and select the 
correct pumping speed automatically to follow the 
programmed temperature profile. 
 

Refer to Linksys32 Manual for information on 
how to program the temperature. 
 

2 

3 

1 
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Setting up the Linksys32 Software 
 

Ensure that the RS232 cable is connected between 
the PC serial RS232 port (Comm port) and the 
CSS450 controller.  Start the Linksys32 software 
by double clicking on the ‘Linksys32 - Shortcut’ 
icon on the PC.  The temperature Control Status 
Display will show the message: 
 

‘No Comm    Programmer not connected’.   
 

This means that the software does not yet recog-
nise the Controller connected to the RS232 Comm 
port. 
 

Got to: File > Connect 
 

 

 

 

 

 

 

 

 

 

 

The software will now ask to ‘Power on your 
Linkam equipment connected to comm port1’ (or 
whichever Comm port has been selected in the 
Linksys32 Setup window). 
 

Click: OK button. 
 

 

 

 

 

 

If the following message appears:  
 

‘No Comm         Cannot open the comm port’ 
 

The RS232 cable may have been connected to a 
different Comm port number other than the one 
selected in the Temperature Programmer Setup 
menu. 
 

Check the back of the PC to see which Comm 
port the RS232 cable is connected to.   
 

Note: if the Comm port is from a PCI card or 
USB-to-Comm port adaptor, it will not be a 
Comm port1 setting. 
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Changing Comm Port Number 
Go to: Setup > Temperature Controller 
 

In the popup window ‘Linksys32 Setup’ make 
sure ‘TempControl’ is selected.  Use PC mouse to 
select the Comm port (2 to 6) the RS232 cable is 
connected to, then click the ‘X’ button in the top 
right hand corner to close the window. 
 

Check the controller is on. 
 

Now connect as before: File > Connect 
 

The software will again ask for ‘Power on your 
Linkam equipment connected to comm port1’ or 
whichever Comm port has been selected in the 
Linksys32 Setup window. 
 

Click: OK 

 

 

 

When a successful connection has been made, the 
software will show ‘Linksys32 : Connected to > 
CSS 450’ in the title bar and show the live tem-
perature in the display.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using Linksys32 Software  
 

Linksys32 Tool Bar 
If the system has connected to the PC successful-
ly, the Tool Bar control panel will appear as 
shown.  This tool bar has three sections.  Refer to 
Linksys32 Manual for the operation of the Tem-
perature and Video Capture Tool Bar.   

Linksys32:  
Tool Bar 

Linksys32: 
Temperature and Video Capture Tool Bar 
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CSS450 Tool Bar 
The CSS450 toolbar is made up of control but-
tons, sensor indicators and status window. 
 

When the tool bar shows this button, then 
the ‘Jog Controls’ will be active.  ‘Gap’ 
setting and ‘velocity’ are controlled manu-

 ally by typing a value.  Click to toggle be-

 tween ‘Jog’ and ‘Motor Profile’ controls. 
 

When the tool bar shows this button, then 
the ‘Shear Motor Profile’ table will be 
active  and shearing functions will be 

controlled by  the values in the profile table.  
Click to tog- gle between ‘Jog’ and ‘Motor Pro-
file’. 

 

This button controls the direction of 
steady shear (clockwise or anti clockwise) 

when the ‘Jog Controls’ are active. 
 

This button Starts the CSS450 motors 
according to setting in either ‘Shear Motor 

 Profile’ or the ‘Jog Controls’ 
 

This button Stops the CSS450 motors 
according to setting in either ‘Shear Motor 

Profile’ or the ‘Jog Controls’. 
 

This button moves the lid to the reference 
point (windows separated by 2500mm). 

 

CSS Status Window 
This shows the current status of the CSS450 e.g. 
the status message ‘The gap motor might need to 
be referenced’ is shown when the CSS450 is first 
connected. 
 

Sensor Indicators 
There are three sensors in the Lid of the CSS450, 
marked with the letters L, R and Z.  L represents 
the Lid sensor, it is lit green when the Lid is in 
place.  R represents the Reference sensor and is lit 
green when the Lid is at 2500mm.  Z represents 
the Zero Sensor and is lit green when the Lid is at 
0mm.  T/B shows which heater is being used to 
display the temperature.  ‘Green’ colour repre-
sents the Base heater and ‘Red’ colour represents 
Top heater. 
 

Jog Controls (Manual Mode) 
When the Jog control button is displayed the user 
can set the gap size by typing any number be-
tween 0 to 2500mm into the Gap setting box.  To 
set rotary velocity, type a value between 1 and 10 
rad/s or drag the slider using the PC mouse. 
 

Linksys32:  
CSS450 Tool Bar 
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Loading the Sample 
 

Click on the “ref” for reference button to ensure 
that the Lid is at the Reference Point.   
 

 

 

 

 

Take note of the warning popup window and 
move the lens clear of the lid  to avoid  damage. 
 

 

 

 

 

 

 

When the motor has stopped moving.  Look at the 
‘Gap (um)’ display and make sure it reads ‘2500’.    
 

The light beside this display is red when the Gap 
Motor is not moving and is green when the motor 
is moving.  
 

 

 

 

 

 

 

 

Make sure the microscope substage is in its low-
est position and the lens nosepiece is rotated to a 
position where the Lid can be easily removed 
without damaging the lens or Lid.   
 

Unscrew the Lid Nuts and remove the Lid .  Place 
the Lid on the Stand (the picture shows the 
CSS450 with the Linkam Imaging Station) and 
place the sample in the middle of the Base win-
dow.   
 

The amount of sample loaded on to the stage 
depends on the gap size that will be used and the 
transparency of the sample (if using transmitted 
light). 
 

Note: If the sample is a solid it can be melted 
before shearing as long as the cable between Lid 
and Base remains connected.  See the Linksys32 
Manual for further information regarding temper-
ature programming. 
 

Replace the Lid carefully making sure the Lid 
Nuts are secure. 
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Start the Shearing Experiment 
 

First click on the Reference button ‘to ensure that 
the Lid is at the ‘Reference’ point of 2500mm.  
Take note of the warning popup window and 
move the lens clear of the lid. 
 

There are two ways to control shearing in the 
CSS450.  The Manual Jog Controls and the Shear 
Motor Profile table.   
 

Using the Shear Motor Profile 

To use the Shear Motor Profile table, make sure 
the ‘Use Motor Profile’ icon          is visible  in 
the tool bar .   
 

If it is not visible, click on the ‘Jog Controls’ icon 
to switch it to the “Use Motor Profile” icon. 
 

Click: View > Shear Motor Profile. 
 

The popup window displays the table.  In this 
table each row is made of a series of cells repre-
senting a ramp in the profile.  Each column repre-
sents a setting for the ramp. e.g. Mode, Gap, 
Strain, Rate, Freq (frequency), Dirn (direction) 
and Time. 
 

A ‘Mode’, ‘Gap’, ‘Dirn’ and ‘Time’ must always 
be completed to enable a successful ramp. 
 

‘Strain’, ‘Rate’ and ‘Freq’ columns only need to 
be completed if the selected ‘Mode’ requires it.  
E.g. if a ‘Steady’ Shear rate ‘Mode’ is selected in 
the ‘Mode’ column, then the table auto completes 
the ‘Strain’ and ‘Frequency’ columns with ‘n/a’ to 
show that these values are not needed for this 
particular ‘Mode’. 
 

Right click in the ‘Mode’ column to show the 
mode drop down menu.  Click on the arrows to 
scroll through the various possible modes. 
 

Stdy = Steady. A continuous shear  rate in the 
specified ‘Direction’ for a specific ‘Time’. 0.001 
to 10rads/sec. 
 

Step = Describes a single motion at a par ticular  
shear rate and strain (angular displacement Ø) in 
the direction set.  Enter a strain value and shear 
rate, 0.001 to 10rads/sec. 
 

Osc = Oscillatory. Descr ibes a motion that 
follows a sine wave using the strain and frequen-
cy settings. (Shear and Strain Explanation, page 
36). 
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Relax = Sets the mode in which no motion 
takes place, only the gap and time need to be 
entered. 
 

Once a ‘Mode’ has been set.  Left Click in the 
‘Gap’ column and enter a value between 0 and  
2500mm. (Gap is the distance between shear 
windows). 
 

The next column is ‘Strain’.  If ‘Step’ or ‘Osc’ 
Modes have been selected, the user will need to 
enter a ‘Strain’ value (Shear and Strain Explana-
tion, page 36).  Left click in the column and 
type the value required. 
 

The next column is ‘Rate’.  If ‘Steady’ or ‘Step’ 
Modes have been selected, the user will need to 
enter a ‘Rate’ value.  
 

The next column is ‘Frequency’.  If ‘Osc’ Mode 
has been selected the user will need to enter a 
Frequency of Oscillation. 
 

The next column is ‘Direction’.  Click the arrows 
to select CW (clockwise) or ACW (anti-
clockwise). 
The next column is ‘Time’.  Enter a time 
(Seconds or Minutes can be selected in the 
CSS450 Setup menu) to set the duration of ramp 
until CSS450 proceeds onto next ramp in profile. 
 

For the information entered into a cell to be regis-
tered by the controller, the user must click into 
another cell.  The information is not stored until 
this has been done.   
 

When the ramp information has been entered, the  
user can check that it is correct by ‘Left Clicking’ 
into the Ramp column, then Right clicking and 
selecting ‘Check Row’ from the drop down list. 
If a cell contains a value that the CSS450 is not 
able to execute, then a warning box will appear 
with a message detailing the possible parameters 
for that particular cell. 
 

A profile may be exist of several ramps (rows). It 
may not always necessary to start the profile from 
Ramp 1. To select the ‘Start’ and ‘End 
Ramp’ (row) Left click into the Ramp column, 
then Right Click on the particular Ramp (or Row) 
you want the Profile to start with and select ‘Start 
Row’ from the drop down list.  Do the same for 
the End Row.  Start Rows are green, End Rows 
are red. 
The profile can be saved for later use.   
 

Click: File > Save > Shear Motor Profile 
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Start the Profile 
Now that the ‘Shear Motor Profile’ table is com-
plete the system can then be used to start shearing 
the sample. 
For additional control of the temperature and 
image capture during the experiment, refer to the 
appropriate sections of the Linksys32 Manual. 
 

To start shearing click on the ‘Start’ button in the 
CSS450 Control Panel.  The ‘Start Ramp’ turns to 
a light blue colour to show that it is the current 
active ramp.  The Status window message will 
change to show that the motors are moving.  To 
stop the profile, click on the ‘Stop’ button at any 
time. 
 

Adjusting the Shear Parameters 
Accessing the Setup Menu: 
To access the Setup menus for the CSS450.  Right 
click on the Tool bar within the CSS450 control 
panel.   
 

General Setup 
Motor Profile Time Units - Specify units for each 
Ramp in the Profile by clicking either ‘Seconds’ 
or ‘Minutes’. 
Temperature Source - The Lid and Base have an 
independently controlled heating element.  The 
user can select whether the temperature displayed 
in the Live Temperature Window is from the Lid 
or Base heater or both (mixed).  If ‘Bottom’ is 
selected, the T/B indicator in CSS450 control 
panel will be lit Green.  If ‘Top’ is selected the T/
B indicator will be lit Red.  If ‘Mixed’ is selected 
the indicator will flash alternately Red/Green. 
Rotary Motor Current - The user can set how 
much current is supplied to motors.  If the sam-
ples have high viscosity, then select ‘High’.  In 
most cases it is OK to leave this feature set to 
‘High’. 
 

Velocities 
Withdrawal Velocities - The two variables that 
can be changed are related to the referencing of 
the CSS450.  The Rotary velocity is the speed at 
which the bottom shear window rotates as the 
Gap is increased.  This Rotary Velocity is to help 
prevent the shear windows breaking when used 
with particularly viscous samples. The Withdraw-
al Velocity is the speed the Lid raises to the refer-
ence point. 
 

Gap Velocity - This is the default speed for  the 
lid movement (up/down) when following the 
Shear Motor Profile. 
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Finish a Shearing Experiment 
 

After the experiment click the Reference to open 
the Lid.   
 

 

 

 

 

Beware of the warning popup window and move 
the lens clear of the Lid to avoid  damage. 
 

 

 

 

 

 

 

Remove the Lid and place it on the Stand (the 
pictures show the CSS450 with the Linkam Imag-
ing Station).  Remove the sample and use a soft 
cloth with a small amount of IPA (isopropanol) to 
clean the quartz windows. 
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Maintenance Procedures 
 
Changing the Windows 
This section is only to be use, if any of the quartz 
windows are broken and need replacing. 
 

Before leaving Linkam Scientific Instrument Ltd., 
each stage is calibrated and checked for parallel-
ism of the Lid and Base windows.   
 

When changing any windows, it is most important 
that the surfaces are clean.  Otherwise the paral-
lelism of the windows and the gap settings will be 
affected. 
Refer to pages 8 and 37 of this manual for the full 
description and part number of the tools and ac-
cessories needed to replace the windows. 
 

External Window Replacement 
Using the External Window Clamp Tool (1), 
unscrew the External Window Ring (2) and re-
move the 18mm diameter quartz window (3).  Do 
the reverse to replace the stage with a new quartz 
window.  Do not over tighten as this could dam-
age the quartz window. 
 

Base Window Replacement 
If you have the CSS-450 purge system, you will 
have a slightly different window clamp tool, see 
page 33. 
 

When the Base window needs to be replaced, it 
should be reassembled as follow: 
 

1. Using the Base Window Carrier Tool (4)  to 
give leverage use the 55mm Window  Clamp 
Tool (5) to unscrew the Window  Clamping 
Ring (6) that clamps the 55mm  diameter 
Quartz Base Window (7) in place.   
2. With the help of the 55mm Window Sucker 
 Tool (8) provided, remove the old quartz win-

 dow.  Then clean the recess where the window 
 sits. 
3.  Place a new quartz window into position and  
 make sure that it drops into the bottom of the 
 recess. 
4. Replace the clamping ring and screw it down 
 until it just touches the window. 
5. Tighten the ring with the tool.  
 

Note: The window clamping ring has a rubber 
seal on its bottom to secure the quartz window in 
place and to give it good thermal contact with the 
heater.  Do not over tighten the clamping ring, as 
it could brake the quartz window.  Hand tight is 
sufficient. 

1 

1 

2 

2 

3 

3 

4 5 

6 8 7 
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Lid Window Replacement 
When the Lid window needs to be replaced, it 
should be reassembled as follow: 
 

1. Using the Lid Window Carrier Tool with Tom-
my Bar (1).  Unscrew the Window Clamping 
Ring (2)  that clamps the 32mm Diameter 
Quartz Tapered Edge Lid Window (3) in place.   

2. Remove the quartz window and clean the 
 clamp thread and the surface of the heater. 
3. Place a new quartz window into position, 
 with the smaller diameter facing the clamp. 
4. Screw the clamp loosely back into position.  As 
 it is being hand tightened, move the window 
 gently from side to side to make sure that the 
 quartz window is centralise and sit in the right 
 position. 
5. Using the tool, tighten  the clamping ring.  It 
 may be necessary to use the tool’s Tommy Bar, 
 but do not use excessive force. 
 

Note: The gap setting may need to be recali-
brated when one or both of the Lid and/or 
Base windows have been replaced.  Refer to 
Setting the Sensors - Zero, Lid and Reference, 
page 28 for more information. 
 

 

1 

2 3 
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Setting the Sensors - Zero, Lid and 
Reference 
 

The CSS450 shearing cell sensors are setup and 
calibrated at Linkam production facility, before 
shipment.   
 

ONLY PERFORM THE FOLLOWING SET-
UP IF YOU ARE REPLACING EITHER OR 
BOTH OF THE LID AND BASE SHEARING 
WINDOWS (page 26 and 27). 
 

There are three sensors, R, Z and L arranged on 
top corner of the Lid.  These three sensors deter-
mine when the Lid is at: 
 

R- The Reference ‘Ref’ point (Lid shear window 
 is 2500mm from Base shear window). 
Z- The ‘Zero’ point (Lid and Base windows 
 are separated by 0mm). 
L- The ‘Lid’ gap just shows the Lid is in correct 
 range  
 

 

 

 

 

 

 

 

 

Manually Setting the Windows to Zero Point 
SWITCH OFF the CSS450 Controller and remove 
the CSS450 shear cell lid.  Fit the Manual Gap 
Setting Tool to the shaft of the Gap Motor.  This 
shaft protrudes from the smaller of the two motor 
covers.  The tool is similar to the Lid Nuts (which 
secure the Lid in place) but have two extra hex 
grub screws (1) inserted in the side.   
 

Slide the tool onto the shaft and tighten the grub 
screws with the appropriate hex key to secure the 
tool in place.  It is now possible to easily turn the 
shaft when the Lid is in place. 

1 
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A microscope is needed to visually determine that 
the shear windows are at the zero point. 
 

Use a felt tip pen to draw a line that bisects the 
aperture on the Base window as seen in the Pic-
ture 

 

 

 

 

 

 

 

 

 

Now draw a line that bisects the aperture in the 
Lid Window. 
 

Replace the Lid on the Base (with out using the 
Lid Nuts) and focus with the microscope on the 
line drawn on the Base window.   
 

 

 

 

 

 

 

 

 

Now turn the Manual Gap Setting Tool to lower 
the Lid.  When both lines come into focus, i.e. 
when both of the shear windows surfaces are 
touching.  This will be the manually set Zero 
Point.  The next step is to setup up the Zero Sen-
sors. 
 

 

Base Window 

Top Window 
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Switch on the controller and reconnect to 
Linksys32. 
 

Click: File > Connect 
 

The Status window may display the message ‘The 
gap motor might need to be referenced’ DO NOT 
click on the reference ‘ref’ button or the Lid will 
move up (2500mm) and the stage will have to be 
manually reset to zero point again. 
 

Using the PC mouse, right click onto the CSS450 
toolbar.  
 

Click and select: Reference   
 

Click ‘OK’ to continue. 
 

There are three sensors pins located on top of the 
Lid.  They are labelled R (reference), Z (zero) and 
L (lid).   
 

Place the Sensor Adjustment Tool on the zero 
sensor pin (Z). 
 

Turn the Sensor Adjustment Tool so that the 
‘Zero’ light in the CSS450 control panel just turns 
green. 
 

One turn of the screw represents a gap of 500mm.  
So to get an accuracy of 1mm, it needs to be 
within 0.72 degrees rotation. 
 

 

 

 

 

When Zero is set, click on the ‘Zero’ button.  The 
Lid will now move up 2500mm to the Reference 
point. 
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Now place the Gap Setting Tool on the Reference 
sensor pin (R) and turn the tool until the Refer-
ence Sensor indicator ‘Ref’ just turns green.  
 

 

 

 

 

 

 

 

 

 

 

 

Then click ‘Ref’.  The Lid will now move down 
500mm, so that the ‘Lid’ Sensor can be set. 
 

 

 

 

 

 

 

 

Place the Gap Setting Tool on the Lid sensor pin 
(L) and adjust until the Lid Indicator ‘Lid’ just 
turns green.  When set, click the ‘Lid’ button.  
The motor will now move the Lid down 1000mm. 
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When the motor stops the there sensors will all be 
set up and referenced.  Ready for sample loading 
in the next shearing run.  
 

Click ‘OK’ and then click ‘X’ in the top corner to 
close the window. 



 

35 

Using the CSS-450 Gas Purge and 
Vertical Seal stage 
 

Only refer to this page if you have purchased the CSS
-450 with additional gas purge / vertical seal option 

 

 

Using the Purge ports 
The vertical seal system allows the stage to be 
used on its side whilst preventing any leakage. To 
help remove or attach the lid to the stage, one of 
these the vertical seal plugs (1) may need to be 
removed to release the pressure inside the cham-
ber. 
 

To apply gas purging to the stage, the vertical seal 
plugs can be removed and replaced with the purge 
adaptor tubes (2). 
 

Once the adaptor tubes are in place, an external 
supply can be connected to them to allow for the 
purging procedure to commence. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Base Window Replacement 
The procedure is the same as the one shown on 
page 26 of this manual except that the window 
clamping tool is slightly different.  
 

The clamping tool for the CSS-450 purge / verti-
cal seal stage is shown on the right. 
 

 

 

 

 

 

 

 

1 

2 
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Troubleshooting 
 

Unable to set a gap, Lid seems stuck 
If the Gap Motor cannot raise/lower the Lid, it is possible that the sample may have set solid between the shear 
windows.   By melting the sample it may be possible to part them and this should be tried first.  In the event 
that this does not work, the following procedure should be used to force the Lid away from the Bottom.  This 
procedure will almost certainly damage one or both of the windows.  Make sure you have the appropriate spare 
windows in ready for the replacement. 
 

1. Remove the instrument from the microscope and take out the external window, (see ‘Changing the Win-
dows, page 26).   Place it on the Stand. 
2. Using the two Jack Screws and hexagonal key provided place the Jack Screws in the holes marked Lid Jack 
Screws,  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Tighten the Jack Screws by hand until they 
come to a stop. 
4. Place the hexagonal key into one of the Jack Screw. 
5. Turn the key a quarter of a turn and then do same to the other.  Alternate with quarter turns so that the lid 
comes straight up.  This will reduce the risk of any damage to the gap mechanism. 
6. Clean the area around the two windows carefully before replacing them.  See the section ‘Changing the 
Windows, page 26’. 
 

Do not use compressed air to clean the instrument as this may blow small fragments of glass into the various 
mechanisms. 
 

Comm port message 
The following message appears: ‘Check to see if another application is using the Comm port selected or that 
you have the Comm port fitted to your computer?’  Change the Comm port used by either moving the RS232 
computer lead to another Comm port or by selecting a new Comm port using the menu. 
 

Select and click: Setup > Comm Port and then selectg a new Comm port number (See Linksys32  
Manual). 
 

Motor doesn’t start 
The shear motor will not start if the Lid is off or the temperature is open circuit.  It may have trouble starting if 
the speed selected in the Jog Window is in excess of 7.5rad/s.  This can be overcome by increasing gradually 
from a lower velocity of say 4.0rad/s up to the desired speed ,  clicking the scroll bars. 
It may have trouble starting if the data in the Shear Motor Profile results in a high shear rate.  Decrease the 
value in the shear rate cell. 
 

 

 

Lid Jack Screws 
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Lid can rock slightly when the lid nuts are off 
It is quite normal for there to be a slight apparent rocking of the Lid when the gap is zero and the lid nuts are 
off.  This is because the windows are touching and the absence of pressure from the lid nuts allows the Lid to 
lift a little.  However, if the gap is larger than zero, there should be no rocking.  In this case, contact Linkam. 
 

Temperature appears to be several degrees below the displayed temperature 
Once the heaters have reached their programmed temperature, it will normally take a minute or so for the heat 
to spread evenly throughout the sample.  If the sample is not in a liquid state, then it may not be conducting 
heat as efficiently as a liquid.  Should there be further cause for suspicion that the heaters are not accurate, 
there are procedures to verify them and check that their mountings have not been disturbed. In this case, con-
tact Linkam. 
 

 

Cooling Fault Diagnosis 
 

Ensure that all connections to the stage and Dewar are as shown in the pictures, page 16. 
 

The cooling rate is less than Specified 
There can be several causes of this problem, the most likely being that one of the connectors has become 
blocked or damaged.  Check that each tube is fitted tightly to the connector and that none of the tubing is twist-
ed.  This is particularly important in regard to the tubes connecting to the stage, as any constrictions of either 
the tubing or the connector will have a drastic effect on the cooling ability of the LNP95 pump.  If the connect-
ors and tubing are OK, check that the black capillary tubing to the Dewar flask is not bent or damaged and that 
the brass filter from the black capillary tubing inside the Dewar is intact and unblocked. If any damage has 
occurred to any of these items then it will be necessary to replace them.  If no damage is found, check that the 
silver block is not constricted.  This can be checked, simply by blowing through one of the coolant pipes.  
Check that there is sufficient liquid nitrogen in the Dewar so that the brass filter is beneath the surface.  If the 
filter is lifted above the surface of the liquid nitrogen water vapour may freeze in the filter and block it.  Thaw 
the filter to melt the ice and dry it before reinserting into the Dewar. 
 

 

 



 

38 

Appendix 1 : Shear and Strain Explanation 
 

Shear Control 
The Base window of the stage is rotated using a 1.8° stepper motor that has 200 steps per revolution 
(360°/1.8°).  Using a technique called “micro stepping” these 200 steps may be divided up into even smaller 
steps for better positioning and lower resonance. Each motor step is broken up into 256 steps giving a resolu-
tion of 256x200 = 51200 micro steps per revolution  
 

The shear motor drives the window carrier through a toothed belt to give a 4:1 velocity ratio so that for a win-
dow carrier velocity of 1 revs/sec the motor has to turn at 4revs/sec.  This also means that the highest resolu-
tion in micro steps of the window carrier is 51200x4 = 204800. 
 

The shear rates and strain values are defined below.  Most Rheology systems use these. 
 

Shear Rate 
The shear rate is related to the rotary velocity at the centre of the heater aperture where the transmitted light 
passes.  It is defined as rw/d where w is the angular velocity in rads/sec, d is the gap setting in mm and r is the 
observation radius (see below). 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The shear rate is used to specify the velocity for the 
step and the steady modes and is limited to the range 0.001 to 10rads/sec.  This velocity range will also affect 
the range of values available in the oscillatory mode, as it is the frequency and amplitude that dictate the angu-
lar velocity. 
 

Strain (Shear) value 
The strain is related to d and the observation radius r and is entered as a percentage value from 0.1 to 40000%.  
For a given gap setting d the angular displacement x gives the Strain or Shear = x/d = rØ/d.  When entering the 
Strain value, d and r are known, so Ø may be calculated and converted to an angular movement in motor steps.  
Therefore the strain sets the angular distance in the step mode and the amplitude in the oscillatory mode. 
E.g.  In step mode a strain value of 1 at a gap setting of 500mm gives an angular distance of: 
    1x500/7500 = 0.066rads or 3.8° 

This angular distance is then converted to a number of motor steps.  In the oscillatory mode there is a limit of 2 
rads for the Strain value. 
 

Observation Radius 
The radius from the centre of the bottom window to the centre of the hole in the heater block (aperture) is 
7.5mm.  The aperture diameter is 2.8mm. 
 

At the observation radius r (7.5mm) the angular rotation Ø gives the displacement x = rØ.  The gap setting is d 
and is specified in mm, Ø is in rads. 
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Part No. Part Name Part Description 

7017 PVC1 Plastic tube for stage body water cooling 

2200 WGI Water/Gas Valve Insert 

2202 WVC Water Valve Connector 

9566 VS Complete Valve Set 

2053 CSS-ACC Accessory Kit, including all Tools. (No windows) 

9575 CSS-LN Lid Securing Nuts (x2) 

2007 CSS-SB Shear Belt 

3066 CSS-SR Stainless Steel Sensor Rods (x3) 

3008 CSS-AS Alignment Screws for CSS450 Lid (x4) 

9560 NUG450 Alignment Kit for CSS450 

3437 W32TQ 32mm diameter Quartz Tapered Edge Lid Window (1.5mm thick) 

3438 W55QC 55mm diameter Quartz Base Window (1mm thick, 5um tolerance) 

9581 W32-55SS Set of Stainless Steel Disc (Replaces Standard Windows for x-ray) 

3081 CSS-CRT 32mm Window Clamping Ring - top 

3071 CSS-CRB 55mm Window Clamping Ring - bottom 

3012 CSS-LR External Window Ring 

2695 W18Q0.5 18mm Diameter Quartz Window  (0.5mm thick) 

0997 ECP Water Circulator Pump (110V) 

0998 ECP Water Circulator Pump (240V) 

3033 N/A Manual Gap Setting Tool 

   

   

   

Appendix 2 : Spare Parts List 
 

Below is a list of spares that may be require in the future.  Contact Linkam or the corresponding  
representative for other spare parts that are not listed below. 
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Appendix 3 : Declaration of Conformity 
 

 

Manufacturers Name:  Linkam Scientific Instruments Ltd 
 

Manufacturers Address:  
    8 Epsom Downs Metro Centre  
    Waterfield 

    Tadworth 

    Surrey 

    KT20 5LR 

    UK 

 

Declares that the products as originally delivered: 
 
Product Name:   Temperature Programmer 
Product Number:   CSS450 
 
has been independently tested and found to comply with the following applicable European Direc-
tives, and carries the CE marking accordingly: 
 
  EMC Directive 2004/108/EC using product standard EN 61326-1:2006 
  Low Voltage Directive 2006/95/EC using product standard EN 61010-1:2010 
 
and also carries the additional certification: 
 
EMC:  FCC CFR47 Part 15B 
 
Safety: CB IEC 61010-1/ EN 61010-1 
   MET UL 61010-1/ CSA C22.2 No.61010-1 under listing E112928 
 
   
 
 
     Date: 12th July 2011 
 

   

 

 

         

   R&D Manager: Peter Grocutt      

Declaration of Conformity  
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Appendix 4 : Technical Specification 
 

CSS450 Stage Technical Specification 
Temperature Range:   Ambient to 450°C (-50°C to 450°C for Cryo-CSS450) 
Temperature Sensor:   Platinum Resistor 
Gap Motor:     Precision 200 step.  256 micro step drive.  
Main Motor:    Precision 200 step.  256 micro step drive. 
 

CSS450 Controller Technical Specification 
Dimensions:    376L x 243W x 87H (mm) 
Weight:     2.6Kg (excluding cables) 
Operating Environment: 5~40°C, 80% relative humidity at 31°C decreasing linearly to 50% at 40°C  
      (without condensation) 
 

Temperature Range:   -196°C to 450°C (dependent on Stage) 
Temperature Resolution:  0.01°C resolution (dependent on Stage) 
Temperature Accuracy:  0.05°C 

Temperature Stability:  0.05°C 

Set Point Resolution:   0.1°C 

 

CSS450 Controller Equipment Ratings 

A.C. Mains Supply:  100-240V at 47-63Hz   

Max current:    3.4A 

Fuse:  

 Current rating  4A 

 Characteristic   T  
 Voltage rating  250V~ 

 Breaking capacity H  
 

The Anti-Surge or Time Lag (T) Fuse must be replaced by one of the same type and rating. 
 

RS232 Computer Interface 

Standard RS232 levels supplied with a cross over RS232 cable. Uses 19200 baud, 1 stop bit and no parity. 
 

USB Interface 

USB Type B connector:  Currently only used for firmware updates. 
 

External input and output sockets 

Green 2.5mm stereo jack socket. Open drain output. Will sink up to 

    50mA at 12V. 
Pink 2.5mm stereo jack socket. Open drain output. Will sink up to  
    50mA at 12V. 
Blue 2.5mm stereo jack socket. Logic level input from 3.3V to 5V. 

0V Gnd 

Signal 

V14MLA 

47pF 

100R 

2N7002 

Pink/Green 

Signal 

Pink/Green 

0V Gnd 

5V 

CSS450  
Output 

In pulse mode 

signal is 

50mS wide 

External equipment 
example of 5V logic 

connection 

10K 
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CSS450 Motor Board 
 
Rotary Motor 
Motor Type:      Bipolar Stepper Motor 
Motor Current:     Programmable up to 2.0A 

Motor Resolution:    256 Micro Steps 

 

Gap Motor 
Motor Type:      Bipolar Stepper Motor 
Motor Current:     Programmable up to 1.0A 

Motor Resolution:    256 Micro Steps 

 

Digital Encoder:     24 bit 
End Stops:      2 

 
Optional LinkPad 

Dimensions:      125L x 172W x 80H (mm) 
Weight:       0.75Kg (excluding cables) 
Operating environment:   5~40°C, 80% relative humidity at 31°C decreasing linearly to 50% at   
        40°C (without condensation) 
Display Resolution:    320 X 240 pixels 

Display Size:     5.7 inch  
User Interface:     Touch screen 

 

LinkPad Eqipment Ratings 

D.C Voltage:      12V    
Max Current:      550mA 
 

LNP95 Liquid Nitrogen Pump 

Dimensions:      376L x 243W x 87H (mm) 
Weight:       3.6Kg (excluding cables) 
Operating Environment:   5~40°C, 80% relative humidity at 31°C decreasing linearly to 50% at   
        40°C (without condensation) 
Tubing:       Silicon Rubber 
 

LNP95 Equipment Ratings 

A.C. Mains Supply:     100-240V at 47-63Hz 
Max current:       1.7A 
Fuse:         Current rating   2A 
         Characteristic    T  
         Voltage rating  250V~ 
         Breaking capacity H  
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Linkam Scientific Instruments Ltd. 
Tel: +44(0)1737 363 476 
Fax: +44(0)1737 363 480 

Email: support@linkam.co.uk 
 

Unit 8 Epsom Downs Metro Centre 
Waterfield, Tadworth, Surrey, KT20 5LR, UK 

www.linkam.co.uk 
 

Version: 1 .0 Date.17-07-2012 

Version: 1.1 Date 05-11-2013 Added a French version of the safety section 

Version: 1.2 Date 16-12-2013 Modified safety cord set information 
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